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DÉCLARATION DE CONFORMITÉ

 

Nous, Digidesign,

2001 Junipero Serra Boulevard, Suite 200

Daly City, CA 94014-3886 États-Unis

Tél :  650-731-6300

déclarons sous notre seule responsabilité que le produit

Mbox

est conforme aux règlements FCC Part 15. 

Consommation de courant : 500 mA

Son utilisation est soumise aux deux conditions suivantes : (1) 
cet équipement ne peut provoquer d'interférences nuisibles, 
et (2) cet équipement doit supporter toute interférence reçue, 
y compris les interférences susceptibles de provoquer un 
mauvais fonctionnement.

REMARQUE : cet équipement a été testé et s'est révélé 
conforme aux limites d'un appareil numérique de classe A, 
conformément aux règlements Part 15 de la FCC. Ces limites 
ont pour but de fournir une protection raisonnable contre les 
interférences nuisibles dans une installation domestique. Cet 
équipement produit, utilise et peut émettre de l'énergie de 
fréquence radioélectrique et, s'il n'est pas installé et utilisé 
conformément aux instructions fournies, il peut provoquer des 
interférences nuisibles aux communications radios. Toutefois, 
aucune garantie n'est donnée que des interférences ne se 
produiront pas dans une installation particulière. Si cet 
équipement produit des interférences nuisibles à la réception 
de postes de radio ou de télévision, ce qui peut être décelé en 
allumant et en éteignant le poste, l'utilisateur peut tenter de 
corriger ces interférences en mettant en œuvre une ou 
plusieurs des mesures suivantes :  
• Réorienter ou déplacer l'antenne de réception.
• Éloigner l'équipement du poste récepteur.

• Connecter l'équipement à une prise électrique différente 
de celle du poste de réception.

• Demander conseil au revendeur ou à un technicien 
radio/TV expérimenté.

Toute modification de l'équipement, si elle n'est pas 
expressément approuvée par Digidesign, peut annuler le droit 
d’exploitation de l'utilisateur.

 

Déclaration de conformité pour le Canada

 

This Class B digital apparatus complies with Canadian ICES-
003.

Cet appareil numérique de la classe B est conforme à la norme 
NMB-003 du Canada.

 

Conformité australienne
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chapitre 1

Mbox Introduction
À propos de Mbox
Merci d’avoir acheté Mbox, produit issu de la 
collaboration entre Digidesign et Focusrite.

Mbox dote votre ordinateur USB d’entrées et de 
sorties audio analogiques et numériques, grâce à 
ses convertisseurs 24 bits analogiques-
numériques et numériques-analogiques de 
qualité professionnelle. 

Utilisé conjointement avec Pro Tools LE de 
Digidesign, Mbox transforme votre ordinateur 
en une station de travail audionumérique 
multipiste extrêmement performante.

Le coffret Mbox contient les éléments suivants :

• Interface audio Mbox.

• CD-ROM d'installation contenant le logiciel 
Pro Tools LE, les plug-in RTAS (Real-Time 
Audio Suite) et les guides en ligne au format 
PDF. Le logiciel DigiStudio est également 
inclus ; voir Guide DigiStudio.

• Guide de démarrage de Mbox qui couvre les 
notions de base concernant l’installation et la 
configuration, et propose également un 
didacticiel préliminaire.

• Câble USB.

• Carte d'enregistrement Digidesign.
Caractéristiques de Mbox
L’interface audio Mbox présente les 
caractéristiques suivantes :

• Deux préamplificateurs micro Focusrite avec 
alimentation fantôme.

• Entrées de préamplification symétriques 
compatibles avec les connecteurs XLR ou les 
connecteurs 6,35 mm et pouvant alterner 
entre un fonctionnement Micro, Ligne ou 
Instrument.

• Entrées et sorties numériques S/PDIF stéréo.

• Sorties moniteur analogiques compatibles 
avec les connecteurs symétriques TRS ou les 
connecteurs asymétriques 6,35 mm.

• Convertisseurs 24 bits A/N et N/A prenant en 
charge les fréquences d’échantillonnage 
44,1 kHz et 48 kHz.

• Convertisseurs A/N/A avec gamme 
dynamique >100 dB.

• Écoute de l’enregistrement avec latence nulle 
et équilibre réglable entre les entrées et la 
lecture.

• Insert TRS analogique sur chaque entrée.

• Sortie casque stéréo 6,35 mm (TRS) ou 3,13 
mm avec contrôle de niveau réglable.

• Alimentation directe à partir du bus USB.

• Bouton Mono pour mélanger le mixage 
d’écoute en entrée.
Chapitre 1: Mbox Introduction 1
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Fonctionnalités de 
Pro Tools LE
Le logiciel Pro Tools LE propose les 
fonctionnalités suivantes :

• Enregistrement et lecture jusqu'à 24 pistes 
audio numériques mono (12 en stéréo), 
suivant la puissance de votre ordinateur.

• Édition non-linéaire, à accès aléatoire et 
mixage avec automation.

• Traitement sonore avec jusqu'à 5 plug-in RTAS 
par piste, limité seulement par la puissance de 
votre ordinateur.

• Jusqu'à 5 inserts et 5 départs par piste.

• Acheminement jusqu’à 16 bus.

• Fonctionnement avec des sessions en 16 ou 
24 bits.

• Enregistrement et lecture jusqu'à 128 pistes 
MIDI (interface MIDI non fournie).

Mbox ne fonctionnera pas correctement si 
vous le connectez à un hub USB. Si vous 
devez absolument utiliser un hub USB pour 
d’autres périphériques USB, utilisez un port 
USB distinct. Mbox doit en effet avoir un port 
dédié pour fonctionner correctement.

Pro Tools LE utilise le processeur de votre 
ordinateur pour mixer et traiter les pistes 
audio. Les ordinateurs fonctionnant à des 
vitesses d'horloge plus rapides peuvent 
supporter un plus grand nombre de pistes et 
assurer le traitement avec davantage de 
plug-in. Référez-vous au guide de référence 
de Pro Tools pour de plus amples 
informations sur les facteurs influençant 
les performances système. 
Guide de démarrage de Mbox
À propos de DigiStudio 
Pro Tools LE 5.2 vous donne accès à 
DigiStudio™, environnement au sein duquel les 
utilisateurs Pro Tools TDM et LE peuvent 
collaborer en sessions sur Internet. DigiStudio 
s’apparente en fait à un studio virtuel avec 
lequel vous pouvez créer des sessions en ligne et 
y travailler. 

Les sessions en ligne correspondent aux sessions 
Pro Tools conventionnelles, la seule différence 
étant qu’avec DigiStudio plusieurs utilisateurs 
peuvent travailler simultanément sur la même 
session en ligne. Ces utilisateurs n’ont, en outre, 
pas besoin de se trouver au même endroit, ni 
dans le même pays. Toute personne utilisant un 
système Pro Tools et possédant une connexion 
Internet peut travailler avec vous au cours d’une 
session en ligne. 

Si vous avez l’intention d’utiliser DigiStudio, 
installez tout d’abord Mbox et Pro Tools LE 
conformément aux instructions situées dans le 
présent Guide de démarrage de Mbox. Une fois 
Mbox et Pro Tools LE installés et configurés, 
consultez le Guide DigiStudio pour savoir 
comment configurer votre système pour Pro 
Tools avec DigiStudio.

Configuration requise

Pour utiliser Mbox sur un Macintosh, vous avez 
besoin des éléments suivants :

• Pro Tools LE 5.2 ou version ultérieure

• Ordinateur Power Macintosh approuvé par 
DigiDesign

• Mac OS 9.1 ou version ultérieure

• Au moins 128 Mo de RAM (192 Mo 
recommandé)



              
• Lecteur de CD-ROM ou lecteur optique 
équivalent

• QuickTime 5.0 ou version ultérieure (version 
5.0.2 incluse dans Pro Tools LE)

• OMS version 2.3.8 ou ultérieure (fournie avec 
Pro Tools LE)

Informations sur la compatibilité

Digidesign peut assurer la compatibilité et 
fournir une assistance uniquement pour le 
matériel et les logiciels testés et agréés par ses 
soins. Pour obtenir la liste des ordinateurs, 
systèmes d'exploitation et périphériques tiers 
agréée par Digidesign, consultez les dernières 
informations de compatibilité sur le site Web de 
Digidesign :

www.digidesign.com/compato/

Configuration du lecteur de 
disque dur
Pour l'enregistrement et le stockage audio sur le 
Macintosh, Pro Tools LE nécessite un ou 
plusieurs lecteurs ATA/IDE ou SCSI validés, 
présentant les propriétés suivantes :

• Formaté avec le système de fichiers HFS ou 
HFS+

• Débit de transfert des données de 3 Mo par 
seconde ou plus rapide

• Vitesse de rotation du lecteur de 7200 trs/mn 
ou plus rapide

Pour consulter les toutes dernières 
informations en matière de compatibilité 
des disques durs et des adaptateurs de bus 
hôte SCSI, visitez le site 
www.digidesign.com/compato/ de 
Digidesign.
• Temps de recherche moyen de 10 
millisecondes ou plus rapide

Utilisation de lecteurs système pour 
l'audio

Bien que Pro Tools autorise l'enregistrement sur 
votre disque dur système, ceci est généralement 
déconseillé. Les performances d'enregistrement 
et de lecture sur les lecteurs de disque dur 
système sont en général moins bonnes que sur 
les lecteurs non-système, avec pour résultat un 
nombre inférieur de pistes et de plug-in.

Vous ne devez enregistrer sur des lecteurs 
système qu'en cas d'absolue nécessité : si votre 
ordinateur ne comporte qu'un seul disque dur 
ou si vos autres lecteurs sont déjà saturés.

Disques durs SCSI

Les disques durs SCSI offrent plusieurs avantages 
par rapport aux lecteurs ATA/IDE. Tout d'abord, 
les disques SCSI peuvent être externes et 
permettent ainsi de stocker des données audio 
sur un média portable que vous pouvez déplacer 
d'un système à un autre. Ils permettent 
également d'obtenir de meilleurs résultats lors 
de l'enregistrement sur de nombreuses pistes ; 
tout enregistrement réalisé sur un nombre 
important de pistes audio à l'aide d'un disque 
dur ATA/IDE sera précédé d'un cours délai.

Initialisation et défragmentation des 
lecteurs

Il est recommandé de démarrer avec un lecteur 
audio venant d'être initialisé. Il est également 
conseillé de défragmenter périodiquement votre 
lecteur audio pour garantir des performances 
stables.
Chapitre 1: Mbox Introduction 3
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Espace de stockage du disque dur

Les pistes audio mono enregistrées en résolution 
16 bits à 44,1 kHz (qualité CD) nécessitent 
environ 5 Mo d'espace disque par minute. Les 
mêmes pistes enregistrées en résolution 24 bits 
nécessitent environ 7,5 Mo par minute. Le 
tableau suivant indique la quantité d'espace 
disque nécessaire en fonction du nombre et de 
la longueur des pistes. Vérifiez l'espace disque 
nécessaire pour vos besoins et planifiez-le.

Espace disque requis pour les pistes audio

Nombre 
de pistes 
et 
longueur

16 
bits à 
44,1 
kHz

16 bits 
à 

48 
kHz

24 bits 
à 

44,1 
kHz

24 bits 
à 

48
kHz

1 piste 
mono, 
1 minute

5 Mo 5,5 Mo 7,5 Mo 8,2 Mo

1 piste 
stéréo (ou 
deux 
pistes 
mono), 
5 minutes

50 Mo 55 Mo 75 Mo 83 Mo

1 piste 
stéréo (ou 
deux 
pistes 
mono), 
60 minutes

600 
Mo

662 
Mo

900 
Mo

991 
Mo

24 pistes 
mono, 
5 minutes

600 
Mo

662 
Mo

900 
Mo

991 
Mo

24 pistes 
mono, 
60 minutes

7 Go 7,8 Go 10,5 
Go

11,6 
Go
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À propos des guides
Le présent Guide de démarrage de Mbox vous 
explique comment installer et utiliser Mbox 
pour enregistrer, monter et mixer plusieurs 
pistes audio dans Pro Tools LE. Vous trouverez 
d'autres informations en consultant les guides 
en ligne suivants :

• Le Guide de référence Pro Tools , décrit de façon 
détaillée le logiciel Pro Tools LE

• Le Guide DigiStudio, décrit l’installation, la 
configuration et l’utilisation du studio virtuel 
en ligne DigiStudio

• Le Guide des Plug-In DigiRack, décrit comment 
utiliser les plug-in RTAS et AudioSuite fournis 
avec Pro Tools LE

• Le Guide des surfaces de contrôle MIDI, décrit 
comment utiliser les surfaces de contrôle 
MIDI, telles que Mackie HUI avec Pro Tools LE

• Les raccourcis clavier (Macintosh et Windows), 
fournit la liste des raccourcis clavier de 
Pro Tools LE

Des versions PDF de ces guides sont installées 
automatiquement avec Pro Tools LE et sont 
facilement accessibles dans le menu d'aide de 
Pro Tools LE. Pour lire ces guides en ligne ou les 
imprimer, vous devez installer Acrobat Reader 
(fourni sur le CD-ROM d'installation de 
Pro Tools LE).



                    
Conventions utilisées dans ce 
guide

Les guides de Digidesign utilisent les 
conventions suivantes pour indiquer les choix 
de menu et les raccourcis clavier :

Les symboles qui suivent permettent de mettre 
en évidence des informations importantes :
.

Convention Action

File > Save 
Session

Choisissez Save Session dans le 
menu File

Contrôle + N Maintenez la touche Control 
enfoncée tout en appuyant sur la 
touche N

Option-clic Maintenez la touche Option 
enfoncée tout en cliquant à l’aide 
du bouton de la souris

Clic à droite 
(Windows)

Cliquez à l’aide du bouton droit de 
la souris

Les conseils aux utilisateurs sont des astuces 
permettant d'optimiser l'utilisation du 
système.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
les données ou les performances du système.

Les renvois dirigent l'utilisateur vers les 
sections correspondantes des autres guides 
de Digidesign.
Choisissez et Sélectionnez

Les termes choisir et sélectionner s'utilisent 
souvent indifféremment en français courant. 
Dans ce guide, cependant, une distinction est 
faite entre ces deux mots.

Sélectionnez Lorsque le guide vous invite à 
sélectionner un élément, il reste sélectionné. C'est 
le cas des éléments d'une boîte de dialogue ou 
d'un menu qui activent ou désactivent une 
option.

Choisissez Lorsque le guide vous invite à choisir 
quelque chose, l'action choisie n'est exécutée 
qu'une fois. C'est le cas avec la plupart des 
commandes de menu ; l'action choisie n'est 
exécutée qu'une fois.

Inscription Digidesign
Remplissez et envoyez la carte d’enregistrement 
fournie avec Mbox. Les utilisateurs inscrits 
bénéficient de 90 jours d'assistance technique 
gratuite à compter de la première fois où ils 
contactent le service d’assistance technique.
Chapitre 1: Mbox Introduction 5



  

6
 Guide de démarrage de Mbox



                    
chapitre 2

Configuration Macintosh
Installation du logiciel 
Pro Tools LE
Avant d’installer Pro Tools LE, vous devez 
configurer les paramètres du système 
d’exploitation. L’installation comprend les 
étapes suivantes :

• Configuration des paramètres du système 
d’exploitation. Voir Paramètres du système 
d’exploitation, page 7.

• Installation de Pro Tools LE. Voir Pro Tools LE 
Installation, page 8.

• Redémarrage de l’ordinateur.

• Connexion de Mbox à l’ordinateur. Voir 
Connexion de Mbox à l’ordinateur, page 12.

• Branchements audio. Voir Établissement de 
connexions de signaux avec Mbox, page 17.

Paramètres du système 
d’exploitation

Pour garantir des performances Pro Tools LE 
optimales, configurez le système d’exploitation 
à l'aide des paramètres suivants.

Procédez comme suit :

1  Dans le Tableau de bord Mémoire :

• Désactivez la mémoire virtuelle.

• Désactivez le disque Ram.
• Réglez le Cache disque sur une 
configuration personnalisée de 512 K.

2  Dans le tableau de bord Economies d’énergie, 
réglez les options de suspension d’activité sur 
Jamais. 

3  Si vous procédez à l’installation sur un 
PowerBook Macintosh, cliquez sur Réglages 
avancés dans le tableau de bord Economies 
d’énergie et vérifiez que l’option d’itération du 
processeur est désactivée.

4  Dans le tableau de bord Apparence, procédez 
comme suit :

• Cliquez sur l’onglet Polices et réglez l'option 
Grande police système sur Chicago. Pensez 
également à désélectionner l’option Lisser les 
polices à l’écran.

• Cliquez sur l’onglet Son et sélectionnez 
Aucune dans la liste déroulante Banque de 
sons.

5  Dans le tableau de bord Gestionnaire 
d'extensions, procédez comme suit :

• Sélectionnez Mac OS 9.1 Base (ou Mac OS 9.2 
Base ou 9.2.2 Base) dans la liste déroulante 
Configuration.

Mac OS 9.1 ou version ultérieure doit être 
installé pour pouvoir lancer Pro Tools.
Chapitre 2: Configuration Macintosh 7
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6  Cliquez sur Redémarrer pour redémarrer 
l'ordinateur.

Pro Tools LE Installation

Après avoir configuré les paramètres du système 
d'exploitation, installez Pro Tools LE.

Pour installer Pro Tools LE sur votre Macintosh : 

1  Insérez le CD d’installation de Pro Tools LE 
dans votre lecteur de CD-ROM ou tout lecteur 
optique équivalent. Cliquez deux fois sur 
Install Mbox Pro Tools LE.

2  Suivez la procédure d'installation affichée à 
l'écran.

3  Dans la fenêtre d'installation, sélectionnez 
l'option d'installation de Pro Tools LE  5.2 pour 
Mbox et définissez l'emplacement d'installation 
sur votre disque dur de démarrage. 

4  Si vous souhaitez utiliser Mbox comme sortie 
son système, sélectionnez le tableau de bord 
Digidesign Sound.

Tableau de bord Gestionnaire d'extensions
Guide de démarrage de Mbox
5  Cliquez sur Install et suivez les instructions 
qui s’affichent à l’écran.

6  Sélectionnez le dossier correspondant à votre 
navigateur Web et cliquez sur OK.

7  Une fois l’installation terminée, cliquez sur 
Quit et installez OMS (voir Installation et 
configuration d’OMS, page 9) si ce n’est déjà 
fait.

8  Cliquez sur Redémarrer

– ou –

Cliquez sur Quit et installez l’une des sessions de 
démonstration en option (voir Installation des 
sessions de démonstration (facultatif), page 9).

À propos des composants de DigiStudio

Lors de l’installation de Pro Tools LE 5.2, le 
programme crée un dossier qu’il intitule 
DigiStudio et le place dans le dossier Pro Tools. 
Ce dossier contient les bibliothèques et les 
fichiers (ainsi que Digi Studio Control) 
nécessaires à l’utilisation conjointe de Pro Tools 
et DigiStudio. Ces composants ne sont pas 
nécessaires à l’exécution de Pro Tools. Pour de 
plus amples informations, reportez-vous au 
Guide DigiStudio.

Pro Tools a besoin d’installer le plug-in 
Rocket dans le dossier des plug-in du 
navigateur Web. Veillez à bien sélectionner 
ce dernier lorsque le système vous y invite.

Composants de DigiStudio 



                                
Installation des sessions de 
démonstration (facultatif)

Le Pro Tools LE CD d’installation comprend 
deux sessions de démonstration permettant de 
tester et de configurer les installations 
matérielles et logicielles : 

• Pro Tools SoundCheck est une session Pro Tools 
simple permettant de vérifier le bon 
fonctionnement du système.

• Be There for MBox est une démonstration plus 
sophistiquée permettant de tester les capacités 
de lecture du système et de vous familiariser 
avec certaines des notions élémentaires de 
Pro Tools.

Pour installer les sessions de démonstration :

1  Insérez le CD d’installation de Pro Tools LE 
dans votre lecteur de CD-ROM ou tout lecteur 
optique équivalent. Recherchez Install PT LE 
Demo Session et cliquez deux fois dessus.

2  Dans la fenêtre d'installation, vérifiez que les 
options d'installation Be There Session et 
SoundCheck Session sont sélectionnées.

3  Définissez l'emplacement d'installation sur 
votre lecteur audio et cliquez sur Install.

4  Une fois l’installation achevée, cliquez sur 
Quit.

Installation et configuration 
d’OMS
Pour utiliser Pro Tools sur un Macintosh, vous 
devez d'abord installer et configurer OMS (Open 
Music System). Situé sur le CD d'installation 
Pro Tools, ce système :
• Enregistre les informations sur les types de 
périphériques MIDI que vous utilisez, la façon 
dont ils sont connectés et les sons qu’ils 
utilisent

• Rend la communication possible entre le 
matériel MIDI et les applications musicales

• Propose des services de synchronisation et 
permet la communication entre les 
applications

OMS enregistre une description de votre studio 
MIDI dans les documents Studio Setup, qui sont 
modifiés dans l’application OMS Setup. Une fois 
qu'OMS est configuré, vos applications 
musicales savent quels périphériques MIDI vous 
utilisez en se référant au document Studio Setup 
en cours.

Il n’est pas nécessaire de posséder un 
périphérique ou une interface MIDI pour créer 
une configuration de studio. Il suffit de 
déterminer une configuration de studio OMS 
pour pouvoir exécuter conjointement 
Pro Tools LE et Mbox, que des périphériques 
MIDI soient ou non connectés au système.

Les sections suivantes décrivent les procédures 
de base de l'installation et de la configuration 
d'OMS. Pour plus de détails, consultez le Manuel 
d’OMS en ligne installé avec Pro Tools.

Installation d'OMS

Le programme d’installation d’OMS se trouve 
sur le CD-ROM d’installation de Pro Tools.

Pour installer OMS :

1  Insérez le CD d’installation de Pro Tools dans 
votre lecteur de CD-ROM ou tout lecteur 
optique équivalent. 

2  Ouvrez le dossier OMS Installer, puis cliquez 
deux fois sur le programme d’installation.
Chapitre 2: Configuration Macintosh 9
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3  Dans la fenêtre d'installation, sélectionnez 
l'option d'installation facile et définissez 
l'emplacement d'installation sur votre disque 
dur de démarrage. Cliquez sur Install.

4  Suivez la procédure d'installation affichée à 
l'écran.

5  Lorsque l'installation est terminée, redémarrez 
votre Macintosh.

Configuration d’un nouveau 
Studio Setup
(Première utilisation d'OMS uniquement)

Avant de configurer OMS, assurez-vous que les 
interfaces MIDI sont connectées selon les 
spécifications du constructeur, et qu'elles sont 
allumées.

Pour configurer un nouveau Studio Setup dans 
OMS :

1  Lancez l'application OMS Setup. Si OMS n'a 
pas encore été configuré, vous serez invité à 
configurer un nouveau Studio Setup. Cliquez sur 
OK.

Si vous utilisez une interface USB, FireWire, 
type PCI ou tout autre type d’interface MIDI, 
ou si vous ne possédez aucune interface ou 
aucun périphérique de connecté, ne 
sélectionnez aucun des deux ports.

Sélection du port pour la recherche du pilote OMS
Guide de démarrage de Mbox
2  Cliquez sur OK pour rechercher les 
périphériques MIDI connectés à l'interface 
MIDI. Pour être détecté, un périphérique doit 
être allumé et ses deux ports MIDI doivent être 
connectés à l'interface MIDI.

OMS recherche et affiche tous les périphériques 
et pilotes MIDI détectés. Il est possible que 
certains instruments anciens ou récents ne 
soient pas reconnus par les routines de détection 
automatique d'OMS.

Si votre interface n'apparaît pas, cliquez sur 
Troubleshoot. Une fois votre interface détectée, 
vous serez invité à rechercher les instruments 
MIDI qui y sont connectés.

Les périphériques non reconnus par OMS 
s'affichent avec un point d'interrogation rouge 
et portent un nom qui correspond à l'interface 
ou au port auquel ils sont connectés. Au besoin, 
ces périphériques peuvent être définis dans 
l'application OMS Setup (voir Définition des 
périphériques MIDI dans OMS, page 11).

3  Cliquez sur OK pour enregistrer le document 
Studio Setup.

Configuration du pilote OMS

Périphérique OMS non défini



                    
Désactivation de Serial DMA dans 
OMS

Pro Tools requiert la désactivation de l'option 
Utiliser le pilote Apple Serial DMA lorsqu'il est 
disponible dans OMS Setup. Si vous ne 
désactivez pas cette option, les fonctions MIDI 
et de synchronisation de Pro Tools ne 
fonctionneront pas correctement.

Pour désactiver Serial DMA dans OMS :

1  Cliquez deux fois sur l'application OMS Setup.

2  Choisissez Edit > Preferences.

3  Désactivez l'option Utiliser le pilote Apple 
Serial DMA lorsqu'il est disponible et cliquez sur 
OK. 

4  Quittez OMS Setup.

Définition des périphériques MIDI 
dans OMS

Si vous possédez des périphériques MIDI, vous 
devez les définir dans OMS pour que Pro Tools 
puisse les reconnaître.

Pour définir un périphérique MIDI dans OMS 
Setup :

1  Cliquez deux fois sur l'icône du périphérique 
dans la fenêtre Studio Setup.
2  Dans la fenêtre MIDI Device Info, sélectionnez 
le constructeur et le modèle du périphérique 
dans les menus contextuels. Si le périphérique 
ne figure pas sur la liste, laissez le modèle sur 
Autre, puis donnez-lui un nom.

3  Sélectionnez le canal de réception du 
périphérique. Si la réception s'effectue sur 
plusieurs canaux, sélectionnez l'option Is 
Multitimbral.

4  Si vous avez l’intention d’enregistrer à partir 
de ce périphérique dans Pro Tools, sélectionnez 
l'option Is Controller. Si le périphérique est 
destiné à être une source ou une destination de 
code temporel MIDI, Beat Clock ou messages 
MIDI, sélectionnez les options appropriées.

5  Cliquez sur OK.

MIDI Device Info
Chapitre 2: Configuration Macintosh 11
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Lancement de Pro Tools LE 
pour la première fois
Saisie du numéro de série

Lorsque vous lancez Pro Tools LE pour la 
première fois, le programme vous demande 
d’entrer votre numéro de série.

Le numéro de série est inscrit sur la page 
intérieure de la couverture de ce guide. Entrez-le 
dans la zone de dialogue lorsque le programme 
vous le demande, en veillant à ne pas omettre 
les espaces ni les majuscules, puis cliquez sur 
Validate.

Si vous désirez tirer parti de DigiStudio en ce qui 
concerne la collaboration en ligne, reportez-
vous au Guide DigiStudio une fois Pro Tools LE et 
Mbox installés. Le Guide DigiStudio décrit 
comment installer, configurer et débuter avec 
DigiStudio.

Saisie du numéro de série de Pro Tools
Guide de démarrage de Mbox
Connexion de Mbox à 
l’ordinateur
Une fois le logiciel Pro Tools LE installé, 
connectez Mbox à l’ordinateur.

Pour connecter Mbox à votre Macintosh :

1  Connectez une extrêmité du câble USB au port 
USB de Mbox.

2  Connectez l’autre extrêmité du câble USB à 
tout port USB disponible sur votre ordinateur.

Mbox ne fonctionnera pas correctement si 
vous le connectez à un hub USB. Si vous 
devez absolument utiliser un hub USB pour 
d’autres périphériques USB, utilisez un port 
USB distinct. Mbox doit en effet avoir un 
port dédié pour fonctionner correctement.



chapitre 3

Connexion de votre studio
Ce chapitre explique comment configurer et 
connecter Mbox à divers types de sources 
d’entrée et de systèmes d’écoute.
Caractéristiques du panneau 
avant de Mbox

Le panneau avant de Mbox intègre les éléments 
suivants :

Figure 1.  Panneau avant de Mbox
Chapitre 3: Connexion de votre studio 13
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Voyant 48 V

Lorsque ce voyant est allumé, il indique que 
l’alimentation fantôme de 48 V est active au 
niveau des entrées Mic/Line. Ces entrées 
permettent de fournir aux microphones 
l’alimentation fantôme nécessaire à leur 
fonctionnement. L’alimentation fantôme est 
activée au moyen du commutateur 48 V situé en 
haut du panneau arrière de Mbox.

À propos de l’alimentation fantôme

Les microphones dynamiques (Shure SM57 par 
exemple) ne requièrent pas d’alimentation 
fantôme, et celle-ci ne les endommage pas. La 
plupart des microphones à condensateur (AKG 
C300 par exemple) ont besoin d'une 
alimentation fantôme. En cas de doute 
concernant l’alimentation fantôme de votre 
microphone, contactez le fabricant, ou lisez la 
documentation qui s’y rapporte.

Sélecteur de source

Ces commutateurs permettent de sélectionner 
parmi les trois types de niveaux d’entrée pour les 
entrées mic/line XLR/TRS analogiques : niveaux 
Mic (microphone), Line (ligne) et Inst 
(instrument).

Commandes de gain

Ces boutons permettent de régler les niveaux de 
gain d’entrée des entrées Mic/Line.

L’alimentation fantôme peut être utilisée en 
toute sécurité avec la plupart des 
microphones, mais elle risque 
d’endommager les microphones à ruban. 
Veillez à désactiver l’alimentation fantôme 
et patientez au moins dix secondes avant de 
connecter ou de déconnecter un microphone 
à ruban.
Guide de démarrage de Mbox
Voyants de crête

Ces voyants se déclenchent juste avant que les 
niveaux d’écrêtage analogiques soient atteints. 
En d’autres termes, si les voyants de crête 
clignotent de temps à autre, cela signifie que le 
signal est sur le point d’atteindre les niveaux 
d’écrêtage, mais ils n’indiquent pas forcément 
qu’il y a distorsion ou écrêtage au niveau du 
signal.

Voyant USB

Le voyant USB indique que le pilote USB 
Digidesign a détecté Mbox sur le bus USB et que 
le chargement du pilote correspondant a réussi. 
Lorsque le voyant USB est allumé, les données 
audio peuvent circuler à l’intérieur ou à 
l’extérieur du système. Voir Dépannage 
concernant la connexion USB, page 20.

Voyant S/PDIF

Ce voyant indique que les canaux 1 et 2 ont été 
réglés pour recevoir un signal d’entrée 
numérique plutôt qu’analogique. Voir E/S 
numérique S/PDIF, page 16.

Commande Mix (Ratio)

Mbox vous donne la possibilité de contrôler les 
signaux d’entrée pendant l’enregistrement, sans 
le retard induit par les convertisseurs A/N/A et le 
traitement effectué sur des applications hôtes. 

Le bouton Mix permet de contrôler cette écoute 
à latence nulle, ce qui vous permet de mélanger 
et de régler le rapport d’écoute entre les entrées 
Mbox et la lecture Pro Tools. Pour n’écouter que 
le signal d’entrée Source, tournez le bouton 
complètement vers la gauche, en position Input. 
Pour n’écouter que le signal de sortie Pro Tools, 
tournez-le complètement vers la droite, en 
position Playback.



Le signal de sortie provenant de la commande 
Mix est acheminé directement vers les sorties de 
ligne TRS et se répercute au niveau des ports 
casque et des ports de sortie S/PDIF.

La possibilité de mélanger et de contrôler les 
niveaux relatifs de la lecture Pro Tools et des 
entrées directes sans latence, s’avère 
particulièrement utile dans le cas des 
enregistrements fractionnés ou de l’entrée de 
signaux audio par l’intermédiaire des 
préamplificateurs du micro ou des entrées 
numériques de Mbox. 

Autre outil impliqué dans le processus 
d’enregistrement (notamment dans le cas 
d’enregistrements fractionnés) : le bouton 
Mono.

Bouton Mono

Le bouton Mono fait la somme des signaux 
d’entrée contrôlés et les centre, mais n’a aucun 
effet sur l’écoute de la lecture Pro Tools. 

La possibilité de centrer les signaux d’entrée (au 
lieu de les écouter en les soumettant à un 
panoramique à l’extrême gauche et à l’extrême 
droite sur les sorties casque) facilite la création 
d’un mixage d’écoute focalisé de qualité. Utilisé 
conjointement avec l’écoute en entrée à latence 
nulle, le bouton Mono permet d’éliminer 
certaines des anomalies typiques (telles que les 
retards de latence et les problèmes liés aux 
mixages d’écoute moins facilement 
contrôlables) qui se sont toujours révélées 
problématiques pour les musiciens et ingénieurs 
du son depuis les débuts de l’enregistrement.

Nombreux sont les cas de figure, bien 
évidemment, dans lesquels vous n’aurez pas à 
utiliser le bouton Mono. Les microphones 
stéréo, les synthétiseurs stéréo et toutes paires 
source dont l’équilibre a été réglé de façon 
appropriée, constituent autant d’exemples de 
sources d’entrée qui offriront de meilleurs 
résultats si le bouton Mono est désactivé. 

Vérification des relations de phase

Vous pouvez également utiliser le bouton Mono 
pour vérifier brièvement la relation de phase 
entre le signal d’entrée de la source 1 et celui de 
la source 2. En général, lorsque les deux signaux 
d’entrée sont déphasés l’un par rapport à l’autre, 
il se produit une perte nette au niveau de 
l’énergie basse fréquence si ces signaux sont 
combinés. 

Lorsque les deux signaux d’entrée sont 
effectivement déphasés, le fait d’appuyer sur le 
bouton Mono produit un son « sourd » issu de 
l’annulation de phase. Ce test rapide effectué à 
l’aide du bouton Mono peut permettre d’éviter 
des problèmes ultérieurs lors du mixage de ces 
pistes. La vérification régulière des relations de 
phase avec le bouton Mono peut également 
aider les ingénieurs débutants à savoir comment 
placer le micro de façon optimale.

Gain de casque

Cette commande permet de régler le niveau de 
sortie des ports Casque avant et arrière, qui 
émettent le signal acheminé vers les sorties 
analogiques 1–2 dans Pro Tools LE, et reflète les 
sorties de ligne.

Sortie casque du panneau avant

Utilisez le port casque du panneau avant pour 
connecter un casque stéréo doté d’un mini-
connecteur de 3,13 mm. 
Chapitre 3: Connexion de votre studio 15
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Si vous insérez un connecteur TRS de 6,35 mm 
dans le port casque situé sur le panneau arrière, 
le port casque 3,13 mm du panneau avant est 
désactivé. 

Caractéristiques du panneau 
arrière de Mbox

Le panneau arrière de Mbox intègre les éléments 
suivants :

Sortie casque du panneau arrière

Utilisez cette sortie casque pour connecter un 
casque stéréo doté d’un connecteur stéréo TRS 
de 6,35 mm. 

Figure 2.  Panneau arrière de Mbox
Guide de démarrage de Mbox
Si vous insérez un connecteur TRS de 6,35 mm 
dans le port casque situé sur le panneau arrière, 
le port casque 3,13 mm du panneau avant est 
désactivé. 

Bouton 48 V

Ce bouton permet d’activer l’alimentation 
fantôme au niveau des entrées Mic pour 
permettre aux microphones de fonctionner. 

Port USB

Ce port USB standard permet de connecter 
l’ordinateur à Mbox. Un câble USB standard est 
livré avec le système. 

E/S numérique S/PDIF

Les ports d'E/S S/PDIF sont des connecteurs 
phono asymétriques à 2 conducteurs (cinch) qui 
utilisent un flux de données numériques de 24 
bits à deux canaux.

Le format d'interface numérique Sony Philips 
(S/PDIF) est utilisé dans de nombreux lecteurs de 
CD et enregistreurs DAT destinés aux 
professionnels et au grand public. Pour éviter 
une interférence RF, utilisez un câble coaxial de 
75 ohms pour les transferts S/PDIF et maintenez 
une longueur de câble de 10 mètres maximum.

Avant de brancher un micro, vérifiez l’état 
du voyant 48 V, situé sur le panneau avant 
de Mbox. Le bouton 48 V se trouve sur le 
panneau arrière, au-dessus du port USB. Il 
est fort probable que vous l’activiez par 
accident en connectant le câble USB.



Sorties de ligne

Il s’agit de ports TRS symétriques pouvant être 
connectés à une console de mixage, à un 
système d’écoute tel qu’un amplificateur de 
puissance stéréo ou toute autre destination 
stéréo afin d’écouter le mixage. 

Les sorties de ligne 1 et 2 lisent les données 
audio acheminées vers les sorties analogiques 1 
et 2 depuis Pro Tools. Ces sorties analogiques 
sont dotées de convertisseurs analogique-
numérique 24 bits.

Sources 1 et 2

Ces entrées symétriques/asymétriques prennent 
en charge une gamme étendue de niveaux 
d’entrée, dont les entrées micro, instrument et 
de niveau ligne. Les ports sont compatibles avec 
les connecteurs d’entrée audio de type XLR, TRS 
ou TS. Pour chaque canal, la commande de gain 
permet de régler le signal d’entrée, 
conjointement avec le bouton Source. 

Inserts 1 et 2

Mbox fournit un point d’insertion sur chaque 
canal d’entrée. Ces ports TRS envoient et 
retournent le signal du canal d’entrée 
directement après le préamplificateur, mais 
avant le convertisseur A/N. Ceci permet 
l’insertion de processeurs analogiques, tels que 
des compresseurs ou des égaliseurs, qui sont 

Les connecteurs XLR ne prennent en charge 
que les entrées de niveau microphone. 
Autrement dit, si vous choisissez Line ou 
Ins, la partie XLR du port est ignorée. De 
même, si vous choisissez Mic, la partie 6,35 
mm du connecteur est ignorée. Ceci est dû 
aux paramètres d’impédance spécifiés pour 
chaque type de connecteur.
généralement utilisés comme inserts sur les 
consoles d’enregistrement analogique 
conventionnelles. Voir À propos des inserts 
analogiques en entrée, page 19.

Établissement de connexions 
de signaux avec Mbox
Vous pouvez utiliser Mbox dans diverses 
configurations audio. Cette section décrit 
l’établissement de connexions de base pour :

• l’écoute ;

• l’enregistrement ;

• l’entrée pour l’enregistrement ;

• le mixage final ;

• les inserts matériels.

Écoute de l’audio

Comme Mbox intègre deux ports casque, vous 
avez le choix entre le port TRS de 6,35 mm, situé 
sur le panneau arrière, et le mini-port de 3,13 
mm, situé sur le panneau avant.

Les sorties de ligne de Mbox lisent l’audio qui est 
acheminé depuis Pro Tools vers les sorties 
analogiques 1-2. Ces sorties peuvent fournir des 
sorties gauche et droite vers un magnétophone à 
deux pistes pour des mixages finaux, ou vers une 
autre destination stéréo. 

Les sorties de ligne de Mbox sont reliées à des 
convertisseurs N/A 24 bits capables de produire 
un signal maximal de +4 dBu. Les connecteurs 
sont des ports TRS ; les connecteurs TS 
asymétriques sont également pris en charge.
Chapitre 3: Connexion de votre studio 17
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Pour brancher le casque :

1  Connectez le casque au port correspondant 
sur Mbox. La sortie casque du panneau avant 
accepte un connecteur de 3,13 mm et la sortie 
casque du panneau arrière accepte un 
connecteur TRS stéréo. 

2  Réglez le volume du casque à l’aide du bouton 
de gain de casque.

Pour effectuer le branchement sur une stéréo :

■ À l’aide de câbles de 6,35 mm, connectez les 
sorties de ligne, situées sur le panneau arrière de 
Mbox, aux entrées correspondantes sur votre 
stéréo. 

Pour brancher des haut-parleurs avec un 
amplificateur de puissance ou des haut-parleurs 
d’écoute auto-alimentés :

■ À l’aide de câbles de 6,35 mm, connectez les 
sorties de ligne, situées sur le panneau arrière de 
Mbox, aux entrées correspondantes sur votre 
console de mixage, votre amplificateur de 
puissance ou vos hauts-parleurs auto-alimentés. 

La sortie casque Mbox peut produire des 
niveaux de sortie très élevés. Une écoute 
prolongée peut entraîner des problèmes 
d’audition. Réglez le volume du casque avec 
modération.

La sortie casque TRS du panneau arrière 
contourne la sortie casque de 3,13 mm du 
panneau avant lorsque vous insérez un 
connecteur TRS de 6,35 mm.

Les systèmes stéréo utilisent souvent des 
connecteurs cinch. Vous pouvez utiliser un 
adaptateur ou un câble spécial pour 
convertir les connecteurs TRS ou TS de Mbox 
en connecteurs cinch utilisables avec votre 
stéréo.
Guide de démarrage de Mbox
Connexion de sources audio à 
Mbox

Il est possible de connecter directement à Mbox 
les sources audio analogiques ou numériques.

Audio analogique

Les signaux audio analogiques sont produits par 
des microphones, synthétiseurs, consoles de 
mixage et instruments dotés de bobines 
magnétiques. Parmi ces sources, les signaux les 
plus faibles sont générés par les microphones et 
instruments à bobines magnétiques, et ils 
nécessitent généralement le plus 
d'amplification.

Les claviers, préamplificateurs et consoles de 
mixage produisent de l’audio de « niveau 
ligne », qui varie d'un équipement à l'autre entre 
les normes –10 dBV et +4 dBu. 

Pour s’adapter à ces différentes sources, Mbox 
est doté de niveaux d’entrée et d’impédance 
qu’il est possible d’alterner, avec réglage du gain 
pour chaque canal d’entrée.

Pour connecter une source audio analogique :

1  Branchez le câble XLR ou TRS directement sur 
l’entrée Mic/Line 1 ou 2 de Mbox. Ces entrées 
acceptent les connecteurs XLR ou TRS. 

2  Faites défiler les choix en appuyant à plusieurs 
reprises sur le bouton Source de chaque canal, 
jusqu’à ce que le voyant correspondant à votre 
choix s’allume.

Pour activer l’alimentation fantôme :

■ Si votre micro nécessite une alimentation 
fantôme, assurez-vous tout d’abord qu’il est 
connecté, puis appuyez sur le bouton 
correspondant à l’alimentation fantôme (48 V).



À propos des inserts analogiques en 
entrée

Les canaux d’entrée analogiques de Mbox 
comportent tous un point d’insertion TRS dédié. 
Ces inserts matériels provoquent la rupture du 
chemin d’entrée analogique avant qu’il soit 
converti en numérique et envoyé à Pro Tools. 
C’est en général à ce moment-là qu’il est 
souhaitable d’insérer un compresseur, un 
égaliseur ou tout autre effet série qu’il faut placer 
en ligne dans le chemin de signal. 

Il s’agit d’inserts matériels, acheminés avant que 
les signaux d’entrée analogiques soient 
convertis en signaux numériques. Il n’est pas 
possible d’effectuer une insertion dans une 
session Pro Tools.

Bien qu’il s’agisse de deux moyens courants 
d’acheminer des processeurs d’effets, il ne faut 
pas confondre les inserts avec les départs et 
retours auxiliaires, tels que présents dans 
Pro Tools et sur les consoles d’enregistrement 
conventionnelles. Les départs et retours sont 
généralement utilisés pour les effets spatiaux et 
les effets d’ambiance que vous désirez mélanger 
parallèlement au signal d’origine, 
contrairement aux inserts, avec lesquels vous 
provoquez la rupture du chemin du signal afin 
de ne recevoir que le signal émis par le dispositif 
d’effet série.

Pour insérer un dispositif, il vous faut un câble 
d’insert TRS doté d’un connecteur TRS à une 
extrémité, divisé en deux connecteurs 
asymétriques. Le connecteur rattaché à la fiche 
correspond au départ et celui qui est rattaché à 
l’anneau correspond au retour.

L’activation de l’alimentation fantôme fait 
circuler 48 V sur les deux entrées 
microphone. 
En général, mais pas toujours, la couleur rouge 
symbolise le positif, ce qui est sous tension, soit 
la fiche, et la couleur noir symbolise le négatif, 
la masse, soit l’anneau.

Pour insérer un dispositif dans le chemin du 
signal :

1  Il vous faut un câble équipé d’un connecteur 
TRS à l’une de ses extrémités qui se subdivise en 
deux connecteurs asymétriques. Le type de 
connecteurs asymétriques dépend des entrées 
du dispositif.

2  Repérez les connecteurs asymétriques et 
déterminez celui qui correspond à la fiche et 
celui qui correspond à l’anneau. 

3  Branchez le connecteur asymétrique 
correspondant à la fiche sur le port d’entrée du 
dispositif.

4  Branchez le connecteur asymétrique 
correspondant à l’anneau sur le port de sortie du 
dispositif.

5  Insérez le connecteur TRS dans le port 
d’insertion de votre choix sur Mbox.

Audio numérique

L’audio numérique représente des formes 
d’onde analogiques utilisant des milliers 
d’échantillons numériques de formes d’onde 
chaque seconde. L’ensemble de l’audio de votre 
disque dur dans une session Pro Tools LE est de 
l’audio numérique.

Mbox comporte des entrées et sorties 
numériques pour l’audio numérique au format 
S/PDIF. 
Chapitre 3: Connexion de votre studio 19
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À propos de S/PDIF

L’E/S S/PDIF (Sony/Philips Digital Interchange 
Format) est disponible sur la plupart des 
appareils DAT, lecteurs de disques compacts et 
autres dispositifs numériques. Chaque 
connexion S/PDIF fournit 2 canaux d’audio 
numérique avec une capacité de 24 bits. 

Pour connecter un dispositif S/PDIF sur Mbox :

1  Repérez deux câbles coaxiaux de 75 ohms 
équipés de connecteurs mâles cinch à chacune 
de leurs extrémités.

2  Connectez la sortie S/PDIF du dispositif à 
l’entrée correspondante sur Mbox et l’entrée 
S/PDIF du dispositif à la sortie correspondante 
sur Mbox.

3  Cliquez sur Setups > Hardware Setup et 
sélectionnez les options appropriées dans les 
listes déroulantes Sync Mode et Ch 1–2 Input.

Duplication des sorties en S/PDIF

Pro Tools LE utilise la duplication des sorties en 
S/PDIF pour « dupliquer » automatiquement 
l’audio envoyé vers les sorties de ligne 1 et 2 sur 
les sorties cinch S/PDIF. Ceci est utile si vous 
écoutez un mixage à l'aide de vos sorties de ligne 
et que vous l'enregistrez en même temps sur un 
dispositif S/PDIF externe.

Connexion d’un enregistreur 
pour le mixage final
Après l’enregistrement et le mixage des sessions 
dans Pro Tools, vous pouvez effectuer un 
mixage final vers un DAT, un magnétophone ou 
tout autre dispositif d’enregistrement stéréo à 
deux pistes.
Guide de démarrage de Mbox
Connexion d’un appareil analogique

Branchez votre enregistreur (magnétophone ou 
autre dispositif analogique) sur les sorties de 
ligne situées à l’arrière de Mbox. Acheminez le 
signal des sorties de ligne 1 et 2 vers les entrées 
gauche et droite respectives de l’enregistreur. 
Ces sorties correspondent aux ports TRS. Vous 
aurez besoin de câbles d’adaptateurs si votre 
appareil de mixage final possède des entrées 
cinch.

Connexion d’un appareil numérique

Si vous possédez un appareil DAT ou tout autre 
périphérique recevant un signal S/PDIF, 
connectez-le aux ports cinch d’entrée et de 
sortie S/PDIF, situés à l’arrière de Mbox.

Dépannage concernant la 
connexion USB
Si le voyant USB ne s’allume pas après avoir 
branché Mbox, alors que le pilote USB 
Digidesign se trouve bien dans le dossier 
Extensions, débranchez le câble USB du port 
USB de Mbox et rebranchez-le.

4  Si le voyant USB ne s’allume toujours pas, 
éteignez l’ordinateur (mise hors tension totale), 
ôtez Mbox et remettez l’ordinateur sous tension. 
Une fois le système d’exploitation lancé, 
reconnectez Mbox.

Si vous effectuez la connexion avec un 
enregistreur DAT DA30 Tascam, vous devez 
définir le format d'E/S S/PDIF dans 
Pro Tools LE.



chapitre 4

Utilisation de Pro Tools
Ce chapitre présente les principales fenêtres et 
fonctions de Pro Tools, ainsi que la procédure 
d'enregistrement audio de base (voir 
Enregistrement de base, page 33). 

Utilisation de ce chapitre

Si vous utilisez Pro Tools pour la première fois, 
ce chapitre vous permettra d'apprendre à 
enregistrer, éditer, automatiser et mixer dans 
Pro Tools. 

Toutes les fonctions décrites dans ce chapitre 
sont expliquées en détail dans le Guide de 
référence de Pro Tools, accessible à partir de 
l'interface en cliquant sur Aide > Guide de 
référence de Pro Tools. Reportez-vous à ce guide 
et à son index afin d'obtenir des informations 
supplémentaires sur toutes les fonctions de 
Pro Tools. 
Principes de base des 
sessions
Les projets Pro Tools sont créés et enregistrés 
sous forme de sessions. Les sessions stockent 
toutes les données audio, MIDI et de piste, ainsi 
que toutes les autres informations relatives à la 
session. Les fichiers audio et de fondu sont 
stockés dans les sous-dossiers du dossier de la 
session.

Pro Tools garde en mémoire la configuration de 
l'interface audio, ainsi que les autres paramètres 
système, et les applique à chaque nouvelle 
session.

Dossier de session avec le fichier de session et les 
fichiers audio et de fondu correspondants
Chapitre 4: Utilisation de Pro Tools 21
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Création d'une Session

La procédure de base pour la création d'une 
session est la suivante :

1  Lancez Pro Tools.

2  Choisissez File > New Session. 

3  Dans la boîte de dialogue New Session, réglez 
la fréquence d'échantillonnage, la résolution et 
le reste des options correspondant à la nouvelle 
session.

4  Sélectionnez l'emplacement d'enregistrement 
de la session. Si vous utilisez des disques 
externes avec le système Pro Tools, veillez à 
sélectionner le bon disque dans la boîte de 
dialogue New Session.

5  Choisissez Save. Les fenêtres Mix, Edit et 
Transport de la nouvelle session s'affichent (voir 
Figure  3, page 23).

Boîte de dialogue New Session
Guide de démarrage de Mbox
Fenêtres principales

Les fenêtres Mix, Edit et Transport constituent 
l'espace de travail principal de Pro Tools. Vous 
pouvez afficher ces fenêtres en les choisissant 
dans le menu Windows. 

Fenêtre Mix Affiche la console de mixage 
Pro Tools, avec ses voies de fader, pour le 
contrôle du niveau de piste, du panoramique, de 
la mise en solo, de la coupure et de 
l'acheminement du signal. 

Fenêtre Edit Affiche les pistes de la session le 
long de la timeline pour l'édition des données 
audio, MIDI et d'automation. 

Fenêtre Transport Affiche les commandes de 
transport standard : Play, Stop, Rewind, Fast-
Forward, Pause et Record. Cette fenêtre peut 
également inclure les affichages Counter et 
MIDI Control.

Fenêtre Session Setup Affiche le statut des 
paramètres de session Pro Tools importants, 
notamment la fréquence d'échantillonnage et le 
format du fichier. 

Pour afficher la fenêtre Session Setup :

■ Choisissez Windows > Show Session Setup.



Figure 3.  Fenêtres de session principales (dans le sens des aiguilles d'une montre en partant de la fenêtre située 
en haut à gauche) : fenêtre Edit, fenêtre Mix et fenêtre Transport.

Pistes

Pistes

Règles

Fenêtre Transport
Paramètres de session

Pro Tools propose différentes règles temporelles 
pour la sélection de la base de temps de la 
session. Les règles temporelles, situées le long du 
bord supérieur de la fenêtre Edit, incluent les 
règles Bars:Beats et Minutes:Seconds. La règle 
temporelle sélectionnée détermine le format des 
compteurs principaux et sert de base pour la 
grille de la fenêtre Edit. 

Pour sélectionner une règle temporelle :

■ Cliquez dans le cercle situé à côté de 
l'affichage de votre choix dans la partie 
supérieure gauche de la fenêtre Edit (Bars:Beats, 
Sample, etc.).
Chapitre
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Enregistrement de sessions

Au fur et à mesure de la création d'une session 
(ajout de pistes et modification des paramètres, 
par exemple), vous souhaiterez enregistrer votre 
travail. Pro Tools propose trois méthodes 
d'enregistrement, chacune regroupant un 
ensemble d'options différent. 

Pour enregistrer une session :

■ Choisissez File > Save Session, Save Session As 
ou Save a Session Copy In. 

Save Session Permet d'enregistrer la session 
ouverte en tant que telle, sans la refermer.

Save Session As Permet de créer une copie du 
fichier de session avec le nom de votre choix. 
Cette option ne permet pas de créer de nouveau 
dossier Audio Files ou Fade Files. Ceci peut 
s'avérer utile si vous souhaitez essayer plusieurs 
arrangements de session sans affecter la session 
d'origine.

Save a Session Copy In  Permet de n'enregistrer 
que les fichiers utilisés dans la session en cours. 
Ceci peut s'avérer utile pour la création de la 
copie finale de la session, en éliminant les 
fichiers audio ou de fondus dont vous n'avez 
plus besoin.

Les sessions sont généralement enregistrées 
pour des raisons de sécurité des données, 
d'archivage et de préparation au transfert 
des projets. En outre, les fichiers de session 
peuvent être enregistrés en vue d'une 
conversion de fréquence d'échantillonnage 
ou de la création de modèles de sessions. Les 
modèles de session correspondent à des 
sessions Pro Tools dotées de pistes, de 
données d'acheminement, de plug-in et 
autres paramètres prédéfinis. Reportez-vous 
au guide de référence de Pro Tools pour de 
plus amples informations sur la création et 
l'utilisation des modèles de sessions.
Guide de démarrage de Mbox
Ressources et paramètres 
système 

Vous pouvez optimiser les performances du 
système en personnalisant de nombreux 
paramètres Pro Tools à partir de la boîte de 
dialogue Playback Engine.

Boîte de dialogue Playback Engine

Cette boîte de dialogue permet de régler les 
tampons, ainsi que les autres paramètres 
système.

Pour configurer les ressources système :

■ Choisissez Setup > Playback Engine. Pour plus 
d’informations, consultez le Guide de référence de 
Pro Tools.

Fenêtre System Usage

Cette fenêtre affiche les informations relatives 
aux performances de l'unité centrale et des 
ressources DSP. 

Boîte de dialogue Playback Engine d'un système 
Pro Tools LE

Vumètres de la fenêtre System Usage



Pour afficher les ressources système et les 
données d'utilisation :

■ Choisissez Windows > Show System Usage. 

Commandes de transport
La fenêtre Transport permet d'accéder à 
l'ensemble des commandes de transport 
Pro Tools. Vous pouvez afficher ou non 
différentes commandes de transport mises à 
votre disposition en les sélectionnant ou 
désélectionnant dans le sous-menu Transport 
Window Shows.

Pour afficher la fenêtre Transport :

■ Choisissez Window > Show Transport 
Window. 

Pour configurer la fenêtre Transport :

■ Choisissez Display > Transport Window 
Shows, puis sélectionnez les options d'affichage 
de votre choix. 

En affichage standard, la fenêtre Transport 
comprend les commandes de transport les plus 
utilisées, telles que Play et Stop. La fenêtre 
Transport étendue fournit les indicateurs de pré-
roll / post-roll, de début, de fin et de durée 
correspondant à la partie sélectionnée de la 
timeline, ainsi que le sélecteur Transport Master. 

Fenêtre Transport

Online

Retour rapide

Arrêt

Lecture

Enregistrer

Retour à zéro

Fin

Avance rapide
La fenêtre peut également afficher les 
commandes MIDI suivantes : Wait for Note, 
Click, Countoff, MIDI Merge, Conductor, Meter 
et Tempo. 

Tempo

Vous pouvez définir un tempo de session à l'aide 
des commandes de tempo MIDI de la fenêtre 
Transport étendue, ou à l'aide de la règle Tempo. 

Pour définir le tempo de la session :

■ Cliquez dans le champ Tempo de la fenêtre 
Transport, puis saisissez le tempo de votre choix. 

Pour battre le tempo de la session :

1  Choisissez Display > Transport Window 
Shows > MIDI Controls. 

2  Dans la section des commandes de transport 
MIDI, désactivez le chef d'orchestre afin 
d'activer le mode Manual Tempo. 

3  Utilisez la barre d'espace pour cliquer sur le 
bouton Tap. 

Clic et métronome

Pro Tools propose ses propres options MIDI 
Click. Cette fonction peut être activée ou 
désactivée à l'aide de l'icône Metronome de la 
fenêtre Transport et est configurable à partir de 
la boîte de dialogue MIDI Click Options. 

Pro Tools commence la lecture à 
l'emplacement du curseur ou au début de la 
sélection. Le paramètre sélectionné pour la 
commande Link Edit/Timeline du menu 
Operations influe également sur la lecture. 
Reportez-vous au guide de référence de 
Pro Tools pour de plus amples informations.
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Pour configurer et activer le clic Pro Tools :

1  Choisissez MIDI > Click Options.

2  Configurez les paramètres de clic en fonction 
des besoins de la source audio MIDI. 

3  Vous pouvez activer ou désactiver le clic 
pendant l'enregistrement ou la lecture à l'aide 
du bouton Click de la fenêtre Transport, au 
niveau de l'affichage MIDI Controls. 

Timeline et navigation
Pro Tools propose différentes méthodes de 
navigation dans les sessions, notamment à l'aide 
de la souris ou en saisissant un emplacement 
dans l'un des compteurs. 

Pour naviguer vers un emplacement dans la 
fenêtre Edit :

■ Cliquez sur l'emplacement de votre choix 
avec la barre d'insertion.

Pour naviguer à l'aide des compteurs :

■ Cliquez dans le compteur principal et saisissez 
l'emplacement de votre choix à l'aide du clavier 
de l'ordinateur. 

Fenêtre Transport avec commandes Click et Tempo

Navigation dans la fenêtre Edit

Commandes 
Tempo

Métronome

Cliquez sur une piste ou sur une échelle temporelle
Guide de démarrage de Mbox
Emplacements mémoire

Les emplacements mémoire constituent une 
autre méthode de navigation dans les sessions. 

Pour définir un emplacement mémoire :

■ Appuyez sur la touche Entrée du pavé 
numérique pendant la lecture ou lorsque celle-ci 
est interrompue. La fenêtre New Memory 
Location s'affiche. Elle permet de définir un 
marqueur, de stocker une sélection ou de stocker 
n'importe quelle combinaison de paramètres 
disponibles. Ces paramètres incluent la hauteur 
de piste, les activations de groupe, les valeurs de 
pré-roll et de post-roll, ainsi que l'affichage ou le 
masquage des pistes. Définissez les paramètres 
du marqueur et cliquez sur OK. 

Pour vous rendre à un emplacement mémoire 
enregistré : 

■ Appuyez sur la touche des décimales du pavé 
numérique, saisissez le numéro du marqueur, 
puis appuyez une deuxième fois sur la touche 
des décimales. 

Navigation dans le compteur

Vous pouvez également appuyer sur la 
touche * du pavé numérique au lieu de 
cliquer sur le compteur. 

Cliquez ici et saisissez un emplacement dans l'un des compteurs



Affichage et zoom

Lorsque vous affichez des pistes dans la fenêtre 
Edit, vous pouvez non seulement régler la 
hauteur des pistes, mais également réaliser des 
zooms verticaux et horizontaux à l'aide du 
sélecteur Track Height et des outils de zoom.

Pour modifier la hauteur de piste :

■ Cliquez sur le sélecteur Track Height et 
sélectionnez une taille d'affichage pour la piste. 

Pour effectuer un zoom sur une partie de piste 
dans la fenêtre Edit :

1  Cliquez sur l'outil Zoom.

Outils de zoom et de hauteur de piste de la fenêtre Edit

De nombreuses commandes, telles que la 
modification de la hauteur de piste, peuvent 
être appliquées à plusieurs pistes en même 
temps. Maintenez la touche Option 
(Macintosh) ou Alt (Windows) enfoncée 
pendant l'opération pour l'appliquer à 
toutes les pistes. Maintenez les touches Maj 
et Option (Macintosh) ou Maj et Alt 
(Windows) pendant l'opération pour 
l'appliquer à toutes les pistes sélectionnées.

Présélections de zoom

 Boutons de zoom

Outil Zoom

Sélecteur Track Height
2  Cliquez ou faites glisser l'outil Zoom pour 
effectuer un zoom avant horizontal sur une 
piste ou une règle. 

Pour effectuer un zoom avant ou arrière par 
incréments :

■ Cliquez sur le bouton Zoom approprié : 

• flèche gauche (zoom arrière horizontal) ;

• flèche droite (zoom avant horizontal) ;

• boutons Waveform et MIDI pour 
augmenter ou réduire le zoom vertical du 
type de piste correspondant (audio ou 
MIDI).

Pro Tools propose également cinq boutons de 
présélection de zoom. Ils permettent d'obtenir 
des niveaux de zoom prédéfinis (vous pouvez 
définir le degré d'agrandissement de chaque 
présélection, session par session).

Pour utiliser une présélection de zoom :

■ Cliquez sur le bouton de présélection de zoom 
approprié (1 à 5).

Pour enregistrer une nouvelle présélection de 
zoom :

■ Maintenez la touche Commande enfoncée et 
cliquez sur un numéro de présélection de zoom 
pour enregistrer le zoom vertical et horizontal 
que vous avez défini sous ce numéro. 

Utilisation des emplacements mémoire pour le 
contrôle du zoom

Les emplacements mémoire Pro Tools 
permettent de stocker de nombreux attributs au 
niveau de chaque marqueur ou emplacement 
mémoire, notamment les paramètres de hauteur 
de piste et de zoom. Vous pouvez utiliser des 
emplacements mémoire qui ne sont ni des 
marqueurs, ni des sélections, mais possèdent des 
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paramètres de hauteur de piste et de zoom, ou 
d'autres options activées, afin d'effectuer des 
zooms avant et arrière à l'aide du pavé 
numérique.

Pistes
Pro Tools permet de créer des pistes audio et 
MIDI qui répondent aux besoins du projet, pour 
l'enregistrement, le prémixage, 
l'acheminement, l'automation et l'édition audio 
et MIDI.

Pour créer une piste :

■ Choisissez File > New Tracks. 

Pro Tools propose quatre types de piste 
différents : pistes audio, entrées auxiliaire, 
faders principaux et pistes MIDI. Les pistes 
audio, les entrées auxiliaires et les faders 
principaux peuvent être mono ou stéréo.

Pistes audio Pistes permettant l'enregistrement 
et la lecture de données audio sur disque dur, 
l'écoute de l'entrée audio activée en 
enregistrement et la modification des régions 
audio.

Entrées auxiliaires Canaux de console de mixage 
audio utilisés pour l'entrée, l'acheminement et 
de prémixage.

Faders principaux Pistes fournissant des 
commandes de canal principal et des options 
pour l'ensemble des chemins de sortie ou de bus.

Boîte de dialogue New Track
Guide de démarrage de Mbox
Pistes MIDI Pistes utilisées pour 
l'enregistrement, la lecture et l'édition des 
données MIDI.

Les pistes audio, les entrées auxiliaires, les faders 
principaux et les pistes MIDI s'affichent sous 
forme de voies verticales dans la fenêtre Mix. Les 
icônes Track Type, situées juste en dessous des 
faders, indiquent le type de piste. 

Dans la fenêtre Edit, les pistes sont affichées 
horizontalement le long de la timeline. La zone 
dans laquelle l'audio s'affiche pour chaque piste 
est appelée playlist. 

Pistes dans la fenêtre Mix

Règles de timeline et piste audio stéréo dans la fenêtre 
Edit 

Audio Entrée Fader MIDI
principalaux.

Timeline 
Affichage 
des règles

Piste audio



Les pistes audio, les entrées auxiliaires, les faders 
principaux et les pistes MIDI peuvent être 
automatisés. (Pour en savoir plus, reportez-vous 
à la section Automation du mixage, page 32.)
Figure 4.  Piste audio stéréo dans la fenêtre Mix

Nom de la piste

Vumètres de niveau 

Curseur de 
Bouton Mute 

Indicateur d'écrêtage

Entrée
Sortie
Volume
Panoramique
Mode Automation

Enregistrer
Solo

(voyant rouge)

Ouverture de la 

Sélecteur de voix

Inserts

Départs

Activation 
de groupe

Curseur de 
volume

(stéréo)

fenêtre de sortie

panoramique
Pistes audio

Toutes les pistes audio (qu'il s'agisse de pistes 
audio disque, d'entrées auxiliaires ou de faders 
principaux) ont des commandes en commun. 
La Figure 4 ci-dessus représente les commandes 
d'une piste audio ou d'une entrée auxiliaire. 

Les pistes de faders principaux possèdent toutes 
les fonctions des pistes audio ou des entrées 
auxiliaires, mais diffèrent de la manière 
suivante. 
Sélecteur d'entrée L'affectation de sortie d'un 
fader principal détermine son entrée ou sa 
source.

Départs Les faders principaux ne permettent pas 
les départs. Utilisez des entrées auxiliaires ou 
affectez plusieurs fois la sortie.
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Pistes MIDI

Les pistes MIDI possèdent des fonctions de 
niveau de piste, de mise en solo et de coupure, 
en plus des commandes d'entrée, de sortie, de 
canal et de programme (patch) MIDI. Le 
volume, la coupure et le panoramique MIDI 
peuvent également être automatisés à l'aide des 
fonctions d'automation de Pro Tools (voir 
Automation du mixage, page 32 pour plus 
d'informations).

Édition
Pro Tools propose de nombreux outils pour 
l'édition des pistes audio et MIDI. L'édition 
s'effectue essentiellement dans la fenêtre Edit. 
La barre d'outils de la fenêtre Edit contient des 
sélecteurs de mode et d'outil d'édition. 

L'édition audio ou MIDI est généralement 
utilisée pour les opérations suivantes :

• correction d'erreurs et remplacement ;

• réarrangement de chansons et de projets ;

• nettoyage du rythme et de la synchronisation 
de piste par alignement des sons avec des 
valeurs Grid, telles que les mesures et les 
temps, le timecode et autres bases de temps ; 

• création de pistes finales à l'aide de sélections 
provenant de prises multiples (également 
appelées piste comp ou compilation).

Modes et outils d'édition (mode Grid, SmartTool 
activés)

Modes d'édition Outils d'édition
Guide de démarrage de Mbox
Playlists et édition non destructive

Les playlists permettent de créer et d'extraire 
plusieurs versions d'édition de piste. Elles 
peuvent correspondre à des prises complètes, 
des enregistrements fractionnés ou des 
ensembles de sélections provenant de prises 
multiples. Vous pouvez dupliquer les playlists 
afin d'enregistrer des éditions et de continuer à 
ajouter des modifications dans la nouvelle 
playlist, tout en sachant que vous pourrez 
toujours revenir à la version précédente. 

Console de mixage
L'environnement de mixage Pro Tools fournit 
de nombreuses commandes de voie standard 
pour le réglage du niveau de piste, du 
panoramique, de la mise en solo et de la 
coupure. Les commandes de mixage et d'E/S 
peuvent être affichées dans les fenêtres Mix et 
Edit.

Acheminement de base du signal

L'acheminement du signal est effectué par 
affectation des entrées et des sorties de piste. Les 
entrées de piste audio peuvent provenir de 
n'importe quelle entrée matérielle. Une fois 
enregistrée, l'entrée d'une piste audio 
correspond à son fichier audio sur le disque. Les 
entrées de piste auxiliaire peuvent correspondre 
à n'importe quelle entrée matérielle ou 
n'importe quel bus de mixage interne. Quel que 

Duplication d’une playlist



soit le type de piste audio, les sorties peuvent 
être acheminées vers n'importe quelle sortie 
matérielle ou n'importe quel départ de bus 
interne.

L'association de ces fonctions d'acheminement 
de signal permet de configurer virtuellement la 
console de mixage adaptée en fonction des 
projets, notamment pour les départs et les 
retours destinés au traitement et au prémixage 
des effets.

Exemple de départ et de retour

Vous pouvez créer des pistes d'entrée auxiliaire 
et les utiliser comme canaux de retour pour les 
bus, ainsi que pour les entrées provenant de 
sources matérielles. 

Pistes audio et entrée auxiliaire configurées pour un 
départ et un retour

Départ Entrée auxiliaire
vers bus 9 à 10 entrée du bus 9 à 10

Fenêtre Send
Faders principaux

Les faders principaux peuvent être utilisés 
comme maîtres de sortie et de bus, ainsi que 
pour le réglage du niveau principal, de la mise 
en solo, de la coupure et de l'affectation des 
inserts (inserts de plug-in ou matériels) de 
l'ensemble des chemins de sortie et de bus mono 
ou stéréo. 

Les choix possibles pour les entrées, les sorties et 
les bus sont configurés dans la fenêtres I/O 
Setup. Pour plus d’informations sur la boîte de 
dialogue I/O Setup, reportez-vous au Guide de 
référence de Pro Tools. 

Plug-in
Les plug-in permettent le traitement d'effets, tels 
que l'égalisation, la dynamique et les détails. 

Les plug-in fonctionnent en temps réel ou non. 
Les plug-in RTAS correspondent à des effets non 
destructifs, qui s'insèrent dans les pistes pour 
traiter l'audio en temps réel (tout comme un 
processeur matériel externe le ferait, pendant la 
lecture). Les plug-in AudioSuite, quant à eux, 
correspondent à des effets destructifs qui 
traitent les fichiers audio sur disque en non 
temps réel.
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Les plug-in en temps réel sont affectés à des 
pistes provenant de l'affichage Inserts de la 
fenêtre Mix ou Edit. Une fois affectés à une piste, 
les plug-in apparaissent dans l'affichage Inserts 
de la piste et peuvent être ouverts à l'aide du 
bouton Insert.

Pro Tools est livré avec un kit complet de plug-
in DigiRack et de nombreux plug-in 
supplémentaires sont disponibles auprès de 
Digidesign et de ses partenaires de 
développement. 

Plug-in Compressor

Pour plus d'informations sur les plug-in, 
reportez-vous au guide des plug-in 
DigiRack, au guide des plug-in Digidesign et 
au chapitre Plug-in du guide de référence de 
Pro Tools. 

Plug-inBouton Insert
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Automation du mixage
L'automation du mixage permet d'enregistrer, 
ou d'automatiser, les modifications apportées 
aux niveaux de piste ou de départ, aux coupures, 
au panoramique et aux paramètres de plug-in. 
Les pistes MIDI permettent uniquement 
d'automatiser le niveau de piste, le panoramique 
et la coupure.

Étapes élémentaires de l’enregistrement 
d'automation :

1  Dans la fenêtre Automation Enable, activez le 
type d'automation (volume, panoramique, 
coupure, niveau de départ, panoramique de 
départ, coupure de départ ou plug-in).

2  Sélectionnez un mode d'automation pour les 
pistes à automatiser (Write, Touch, Latch ou 
Trim). 

3  Lancez la lecture et démarrez l'enregistrement 
de l'automation en réglant les faders et autres 
contrôles en conséquence. Pro Tools enregistre 
toutes les modifications apportées aux 
paramètres activés.

Activation de l'automation (à gauche) et définition du 
mode d'automation pour une piste (à droite)



Une fois enregistrée, l'automation peut être 
réenregistrée, ou affichée et modifiée 
graphiquement dans la fenêtre Edit. 

Enregistrement de base
Cette section explique comment enregistrer des 
pistes audio et MIDI à l'aide de Pro Tools. 

Acheminement de l'audio vers une 
piste

Pour acheminer de l'audio vers une piste :

1  Vérifiez les connexions aux instruments. 
Reportez-vous au guide de l'interface audio pour 
plus d'informations sur la configuration du 
studio.

Automation du volume d'une piste dans la fenêtre Edit

Pro Tools propose également un mode 
Automation Safe permettant de protéger 
l'automation de plug-in contre tout 
effacement, ainsi que de nombreuses 
préférences d'automation permettant de 
régler les performances avec précision. 
Reportez-vous au Guide de référence de 
Pro Tools.

Affichage de piste réglé sur Volume

Point d'inflexion d'automation pour le volume
2  Créez une piste audio pour l'enregistrement 
en sélectionnant File > New Track. Sélectionnez 
1 Mono Audio Track et cliquez sur Create.

3  Dans la fenêtre Mix, recherchez les 
commandes d'E/S de la piste. Si elles ne sont pas 
visibles, sélectionnez Display > Mix Window 
Shows > I/O View. L'affichage I/O se trouve sous 
les départs et au-dessus des boutons Solo et 
Mute.

4  Cliquez sur le bouton Input de la nouvelle 
piste. 

Dans le menu contextuel, sélectionnez l'entrée 
que vous souhaitez enregistrer. Le menu affiche 
le nom des entrées définies dans la boîte de 
dialogue Hardware Setup (ou I/O Setup).

Définition des niveaux

Réglez le niveau de l'entrée à la source 
(instrument, préamplificateur de micro ou 
console de mixage) afin de définir les niveaux 
d'enregistrement de Pro Tools. Le secret du 
réglage des niveaux d'entrée est d'obtenir le 
signal le plus fort possible sans atteindre 
l'écrêtage numérique. Les signaux qui atteignent 
la partie supérieure de l'afficheur de Pro Tools 
utilisent une plage de bits plus étendue (les 24 
bits qui constituent chaque échantillon sonore). 
Plus vous réussissez à maximiser cette plage de 
bits, plus le son sera de bonne qualité. En 
définissant des niveaux optimaux, vous réduirez 
au maximum les bruits et les distorsions.

Acheminement d'une entrée vers une piste mono
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Enregistrement d'une piste 
audio

Pour enregistrer une piste audio :

1  Activez l'enregistrement de la piste de votre 
choix et affectez-lui une entrée. Réglez les 
niveaux d'entrée de façon appropriée.

Vous devez surveiller l'écrêtage numérique. 
L'écrêtage survient lorsque vous envoyez à 
un périphérique audio un signal plus fort 
que ce que les circuits peuvent accepter. Il en 
résulte une distorsion. L'écrêtage numérique 
est brutal et n'est généralement pas agréable 
à l'oreille. Vous devez donc surveiller ces 
afficheurs !

L'augmentation du gain accroît le niveau de 
bruit. Assurez-vous que le signal de sortie du 
périphérique connecté est aussi puissant que 
possible, sans créer de distorsion.
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2  Affichez la fenêtre Transport (Windows > 
Show Transport) et cliquez sur Return to Zero, 
afin d'être sûr de commencer au début de la 
session. Vous pouvez également enregistrer 
selon la plage de temps correspondant à votre 
sélection ou à partir de l'emplacement du 
curseur dans la fenêtre Edit.

3  Cliquez sur le bouton Record de la fenêtre 
Transport pour activer l'enregistrement.

4  Cliquez sur Play ou appuyez sur la barre 
d'espace pour enregistrer sur toutes les pistes 
actives.

5  Commencez à jouer de votre instrument.

6  Cliquez sur le bouton Stop de la fenêtre 
Transport ou appuyez sur la barre d'espace 
lorsque vous avez terminé l'enregistrement.
Enregistrement au début d'une session

Cliquez sur Play pour démarrer l'enregistrement

Retour à zéro Cliquez ici pour
enregistrer à partir du début de
la session

Cliquez ici pour activer l'enregistrement
(devient rouge vif)



Enregistrement à partir de l'emplacement du curseur dans la fenêtre Edit

1

23

4

5

Cliquez sur l'outil Selector

Activez une piste pour 
l'enregistrement

Cliquez sur Play pour démarrer l'enregistrement

Cliquez ici pour activer l'enregistrement (devient rouge vif)

La flèche rouge indique que 
l'enregistrement aura lieu au 
niveau du curseur

Placez le curseur là où 
vous souhaitez 
démarrer 
l'enregistrement
Pour lire une piste enregistrée :

1  Désactivez l'enregistrement sur cette piste en 
cliquant à nouveau sur le bouton Record. Ce 
bouton ne doit plus être en surbrillance.

2  Cliquez sur le bouton Play de la fenêtre 
Transport ou appuyez sur la barre d'espace pour 
lire la piste. 

3  Cliquez sur le bouton Stop de la fenêtre 
Transport ou appuyez sur la barre d'espace 
lorsque vous avez terminé l'enregistrement.
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Enregistrement de la longueur d'une sélection dans la fenêtre Edit

1

23

4

5

Cliquez sur l'outil Selector

Les flèches qui délimitent la sélection 
s'affichent en rouge, pour signaler que 
l'enregistrement aura lieu dans la session

Activez une piste pour 
l'enregistrement

Cliquez ici pour activer l'enregistrement (devient rouge vif)

Cliquez sur Play pour démarrer l'enregistrement

Sélectionnez la 
longueur à enregistrer
Enregistrement MIDI

Pour configurer une nouvelle piste MIDI pour 
l'enregistrement :

1  Choisissez File > New Track, spécifiez 1 MIDI 
Track, puis cliquez sur Create.

2  Dans la fenêtre Mix, cliquez sur le sélecteur de 
périphérique et de canal MIDI de la piste et 
affectez un périphérique et un canal à partir du 
menu contextuel.
 3  Si vous le souhaitez, vous pouvez affecter un 

changement de programme par défaut à la piste 
en cliquant sur le bouton Program de la fenêtre 
Mix, puis en effectuant les sélections de 
programme et de banque nécessaires et en 
appuyant sur Done. Les numéros de programme 
par défaut sont transmis lors de la lecture d'une 
piste.

Sélecteur de périphérique et de canal MIDI



4  Dans la fenêtre Mix, activez en enregistrement 
la piste MIDI.

5  Vérifiez que MIDI > MIDI Thru est 
sélectionné, puis jouez quelques notes sur votre 
contrôleur MIDI. L'instrument MIDI affecté à la 
piste doit émettre un son et les afficheurs de la 
piste doivent témoigner d'une activité MIDI.

Pour enregistrer la nouvelle piste MIDI :

1  Vérifiez que la piste MIDI à enregistrer est 
activée en enregistrement et reçoit les données 
MIDI.

2  Dans la fenêtre Transport, cliquez sur Return 
To Zero afin d'assurer que l'enregistrement 
commencera au début de la piste. Vous pouvez 
également enregistrer selon la plage de temps 
correspondant à votre sélection ou à partir de 
l'emplacement du curseur dans la fenêtre Edit. 

3  Cliquez sur le bouton Record de la fenêtre 
Transport.

4  Cliquez sur Play dans la fenêtre Transport ou 
appuyez sur la barre d'espace pour lancer 
l'enregistrement.

– ou –

Si vous utilisez l'option Wait for Note, les 
boutons Play, Record et Wait for Note 
clignotent. L'enregistrement commence dès la 
réception du premier événement MIDI.

– ou –

Si vous utilisez l'option Countoff, cliquez sur 
Play. Les boutons Play et Record clignotent 
pendant le décompte, puis l'enregistrement 
commence.

5  Jouez de votre instrument MIDI.
6  À la fin de l'enregistrement, cliquez sur Stop 
dans la fenêtre Transport, ou appuyez sur la 
barre d'espace. Les nouvelles données MIDI 
enregistrées s'affichent sous la forme d'une 
région MIDI au niveau de la piste, dans la 
fenêtre Edit et dans la liste MIDI Regions.

Pour lire la piste MIDI enregistrée :

1  Annulez l'activation en enregistrement de la 
piste MIDI, afin de désactiver le mode Record-
Ready.

2  Dans la fenêtre Transport, cliquez sur Return 
to Zero.

3  Cliquez sur le bouton Play de la fenêtre 
Transport pour commencer la lecture. Les 
données MIDI enregistrées sont lues avec 
l'instrument et le canal affectés à la piste.

Écoute des instruments MIDI sans console de 
mixage

Créez une entrée auxiliaire pour l'écoute de 
l'instrument MIDI. Les entrées auxiliaires 
fonctionnent comme entrées pour les signaux 
véhiculés par des bus internes et les sources 
audio externes.
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Pour configurer une entrée auxiliaire pour l’écoute 
MIDI :

1  Connectez la sortie audio de l'instrument 
MIDI aux entrées appropriées de l'interface 
audio.

2  Choisissez File > New Track et indiquez une 
piste Auxiliary Input (stéréo ou mono), puis 
cliquez sur Create.

3  Cliquez sur le sélecteur d’entrée du canal 
d’entrées auxiliaires et choisissez l’entrée à 
laquelle votre instrument MIDI est connecté. 

4  Cliquez sur le sélecteur de sortie du canal 
d’entrées auxiliaires pour choisir une sortie.

5  Réglez le niveau de l’entrée auxiliaire avec son 
fader de volume.
Guide de démarrage de Mbox
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